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Scripted Lecture

Joe’s Classic Cars Inc.

Joe from Joe’s Classic Car has provided you with an Excel workbook and an Access database so that you can experiment with implementing VBA code. He wants to make sure you can succeed on some basic VBA commands before having you work on larger more detailed files.

Introduction to VBA
STEP 1: DISPLAY VBA AND GET HELP
a. Open the exp2010_vba01_script_JoesClassicCars .xlsm file (click the enable content button if needed), and then save it as exp2010_vba01_JoesClassicCars_Solution.
b. *If the Developer tab is not displayed, click the File tab, click Options, click Customize Ribbon, click the Developer check box in the Main Tabs list, and then click OK.
c. Click the Developer tab, and then click Visual Basic in the Code group.
d. Click Help on the toolbar, and then click Microsoft Visual Basic for Applications Help from the drop down menu.
e. Type Worksheet Object in the Search help box, and then click Click to search.
f. Find the Worksheet.NamesProperty (Excel) and click on it. Read the information and print it if you wish.
g. Type Workbook Object in the Search help box, and then click Click to search.
h. Find the Workbook Members (Excel) and click on it. Read the information and print it if you wish.
i. Close the Help Window but leave the VB Editor open for the next step.

STEP 2: CREATE A PROCEDURE TO SORT RECORDS IN EXCEL
a. Move to the end of the module by pressing CTRL+END then press ENTER.
b. Type Sub SortByValue then press Enter.
c. Type ' Sort by value in ascending order and then press Enter.
d. Press Tab. Type Range("A3:I15").Select and then press Enter.
e. Type ActiveWorkbook.Worksheets("Classic Cars").Sort.SortFields.Clear and then press Enter.
f. Look at Figure 1 and notice the lines that are Selected. Select the same lines in your SortByMake macro, stopping after the End With statement, click Copy on the Standard toolbar, click below the line of code you typed in the SortByValue procedure, and then click Paste on the Standard toolbar.
g. Look at Figure 1 and notice the range that the red arrow points to. Find this line in your code select A4:A15, and then type H4:H15.
h. Select xlDescending on the same line as the range you changed in step g, and then type xlAscending.
i. Click Save on the toolbar.
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Figure 1 SORT by Make Procedure

STEP 3: RUN VBA PROCEDURES
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Figure 2 Sorted by Value
a. Make sure the insertion point is within the SortByValue procedure you just created.
b. Click Run Sub/UserForm (the green triangle) on the toolbar.
c. Minimize the VB Editor, and then look at the Excel workbook. The worksheet should look like Figure 2.
d. Click Macros in the Code group on the Developer tab, select SortByMake in the dialog box, and then click Run. Notice the change in the order.
e. Click Macros in the Code group on the Developer tab, select SortByValue in the dialog box, and then click Run.
f. Save the workbook. Exit Excel, which will also close the VB Editor.


STEP 4: CREATE A PROCEDURE TO CLOSE A FORM IN ACCESS
a. Start Access, open exp2010_vba01_script_JoesCars, and then save it as exp2010_vba01_JoesCars_Solution.
b. Open the frmCustomers form, and then click each button at the bottom of the form: About, Close Form, and Quit. Only the Quit button has code behind and it exits the database.
c. Open exp2010_vba01_JoesCars_Solution.accdb again, click the Database Tools tab, and then click Visual Basic in the Macro group to open the VB Editor.
d. Double-click Joe's Classic Cars in the Project Explorer, double-click Microsoft Access Class Objects, and then double-click Form_frmCustomers. 
e. Click in the code window, and then press Ctrl+End to go to the end of the code. Type Private Sub cmdClose_Click() and then press Enter twice.
f. Press Tab. Type DoCmd.Close and then press Enter.
g. Click Save on the toolbar, and then close the VB Editor.
h. Click Form View on the right side of the status bar to display the form in Form view. Click Close Form at the bottom of the form.
i. Keep Access open.

STEP 5: CREATE A PROCEDURE TO DISPLAY A MESSAGE BOX IN ACCESS
a. Click the Database Tools tab if necessary, Open the frmCustomers form, and then click Visual Basic in the Macro group.
b. Create the procedure for the About button by pressing Ctrl+End to go to the end of the code, and then press Enter. Type Private Sub cmdAbout_Click() and then press Enter twice.
c. Press Tab. Type MsgBox "Joe’s Custom Cars when you want the very best", vbInformation, "Joe’s Custom Cars" and then press Enter.
d. Click Save on the toolbar, and then close the VB Editor.
e. Click Form View on the right side of the status bar to display the form in Form view. Click About at the bottom of the form.
f. Click OK in the message box, click Close Form at the bottom of the form, and then exit Access.



Variables, Constants, Input, and Output
Joe needs you to create procedures that perform calculations in the Excel workbook and Access database. Since some of his insurance rates are rising, he needs to be able to find a car based on the model, locate the insurance cost, and apply the rate increase to that particular car. 
STEP 1: DECLARE A CONSTANT AND THREE VARIABLES
a. Open the macro-enabled exp2010_vba01_JoeCars_Solution workbook in Excel, save it as exp2010_vba01_JoeCars_Solution2, and then display the VB Editor.
b. Click at the top of the Code window, type Sub CalcInsurance() and then press Enter twice.
c. Press Tab. Type ' Declarations and then press Enter.
d. Type ConstInsRate as Single = 0.075 then press Enter.
e. Type Dim strModel as String then press Enter.
f. Type Dim curFindInsAmt as Currency then press Enter.
g. Type Dim curIncreaseAmt as Currency then press Enter.
h. Click Save on the toolbar.
STEP 2: ENTER THE ID TO SELECT THE SALARY
a. Press Enter. Type ' Set the active cell to A4 and then press Enter. Type Application.Goto Reference:="R4C1" and then press Enter twice.
b. Type ' Display input to get model and then press Enter. Type strModel = InputBox("Enter the Model", "Find Current Insurance Premium") and then press Enter twice.
c. Type ' Use Find dialog box to find the Model and then select the respective Insurance Value
d. Type in the code below, Spaces, Periods and Underlines are VERY IMPORTANT. If even one space is missed or added the code will not run. There are spaces before and after the underlines at the end of the first 2 lines.
Cells.Find(What:=strModel, After:=ActiveCell, LookIn:=xlValues, LookAt:= _
xlWhole, SearchOrder:=xlByColumns, SearchDirection:=xlNext, MatchCase:=False _
, SearchFormat:=False).Activate
Press Enter.
e. Type ActiveCell.Offset(0, 8).Select and then press Enter.
f. Type curFindInsAmt = ActiveCell.Value
g. Click Save on the toolbar.
STEP 3: CALCULATE AND DISPLAY THE INCREASED INSURANCE AMOUNT
a. Press Enter twice. Type ' Calculate insurance increase and display output and then press Enter.
b. Type curIncreaseAmt = curFindInsAmt * InsRateand then press Enter. 
c. Type MsgBox "The rate increase for the " & strModel & " is " & Format(curIncreaseAmt, "Currency"), vbInformation, "Increase". Press Enter then click Save.
d. Click Run Sub/UserForm on the toolbar.
e. Type Mustang then click OK. See Figure 3.
f. [image: ]Click OK in the message box. Close the VB Editor, and then save and close the workbook.Figure 3 Amount of Increase


STEP 4: CREATE A SUB PROCEDURE IN ACCESS

a. Open the exp2010_vba01_JoesCars_Solution database in Access, and then save the database as exp2010_vba01_JoesCars_Solution2.
b. Double-click the frmClassic Cars form. 
c. Click the Database Tools tab, and then click Visual Basic in the Macro group.
d. Double click the Form_frmClassic Cars in the Project Explorer then click in the Code window. Press Ctrl+End to position the insertion point after all existing code, and then press Enter.
e. Type Private Sub cmdIns_Click() and then press Enter twice. Press Tab.
f. Type the first comment and the five declarations shown in Figure 4, and then press Enter twice.
g.  Type the second comment and the four statements after it as shown in Figure 4, making sure you type it exactly as shown.
h. Type the third and fourth comments and the lines after them.
i. Type the fifth comment and the lines after it.
j. Click Save on the toolbar, and then close the VB Editor.
k. Click Form View on the status bar to display the open form in Form view if necessary, and then click the Insurance button.
l. Click OK, and then exit Access.
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Figure 4 Insurance Button


Decision Structures
Joe wants you to finish the coding on the Access forms. 
STEP 1: CREATE AN IF...THEN DECISION STRUCTURE

a. Open the exp2010_vba01_JoesCars_Solution2 database in Access, and then save the database as exp2010_vba01_JoesCars_Solution3.
b. Open the form frmCustomer in Form View.
c. Open the VB Editor, double-click Form_frmCustomers in the Project Explorer to display the code in the Code window.
d. Select the code for the Private Sub cmdQuit_Click() procedure. Do not select this header or the End Sub statements. Press Delete to delete the statements within this procedure.
e. Type the code shown in Figure 5. 
[image: ]
Figure 5 Quit Button
f. Click Save on the toolbar, and then close the VB Editor.
g. Click Quit in the form.
h. Click No in the message box.
i. Click Quit again, and then click Yes in the message box to close the database.

STEP 2: CREATE AN IF...THEN...ELSE DECISION STRUCTURE
a. Open the exp2010_vba01_JoesCars_Solution3 database in Access and open frmClassicCars in Form View.
b. Open the VB Editor, and then display the code for the Form_frmClassic Cars in the Code window.
c. In the declaration, change sngRate from a constant to a variable by selecting Const in the variable definition for the sngRate constant and replacing it with the word Dim. Select =0.075 at the end of that line and delete it.
d. Click on the line below the last variable declaration and type Dim intYear as Integer. Then press the Enter key twice. Enter the code shown in Figure 6.
e. Click Save, and then close the VB Editor.

[image: ]Figure 6 If Than Else
f. Check Record 1—the premium should be $4,550 or an increase of 7.5% of the value. Check Record 5—the premium should be $2,812.50 or an increase of 5% of the value.
g. Click OK to close the message box, and then click Close Form.

STEP 3: CREATE A SELECT CASE STRUCTURE
Joe wants credit approval to show up immediately on the customer’s record based on their credit rating. An A rating is automatically approved, a B rating has to go through Joe so they get a maybe, and a C rating is automatically disapproved.
a. Open the VB Editor if you closed it after the last step.
b. Double-click Form_frmCustomer then click in the code window. Press Ctrl+End then press Enter twice.
c. Type Private Sub cmdCredit_Click then press Enter twice, and then Tab.
d. Enter the rest of the code shown in Figure 7.
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Figure 7 Select Case
e. Click Save on the toolbar, and then close the VB Editor.
f. Open frmCustomer in Form View, and then click Credit Approval. For the first record the answer should be Maybe.
g. Move to the fourth record and click the Credit Approval button. The answer for this record should be Yes. Move to the fifth record and click the same button the answer should be No.
h. Close the form, close the database, and then exit Access.


Repetition Structures
Joe wants to be able to enter a model name and determine the total 5-year insurance cost based on the current premiums, and the total 5 year.
STEP 1: CREATE A FOR...NEXT LOOP
a. Open exp2010_vba01_JoeCars_Solution2 in Excel then save it as exp2010_vba01_JoeCars_Solution4, and then open the VB Editor.
b. Position the insertion point before the Sub CalcInsurance() statement. Type Sub Display5YearInsurance() and then press Enter twice.
c. Type the comment and the declarations shown in Figure 8.
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Figure 8 For Next Loop Declarations
d.  Scroll to the CalcInsurance() procedure, start selecting with the comment Set the active cell to A4 through curFindInsAmt = ActiveCell.Value. Copy the selected statements, and then paste them after the declarations in the Sub Display5YearInsurance() procedure.
e. Change the curFindInsAmt to curInsAmt in the copied procedure statement.
f. Click at the end of the curInsAmt statement, press Enter twice, and then type the code shown in Figure 9.
[image: ]
Figure 9 5-Year Premium
g. Click Save on the toolbar, click Run on the toolbar, and then select Run Sub/UserForm.
h. Type Mustang in the message box then click OK. The cumulative 5-year premiums show in a message box.
i. Click OK in the message box.
STEP 2: CREATE A DO WHILE LOOP
Joe considers the 5-year premium to be a success, and asks you to write a procedure that will calculate a 3.5% increase in value each year—output the Insurance cumulative premium along with the increased value.
a. Display the VB Editor in Excel again, position the insertion point before the Sub Display5YearIns() line, type Sub DisplayValueIncrease and then press Enter twice.
b. Press Tab. Type ' Declare Variables and then press Enter. Enter the declarations shown in Figure 10.
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Figure 10 Declarations
c. Select and copy the 'Set the active cell comment through intCount = 1 in the Display5YearIns(), and then paste it into the DisplayValueIncrease() procedure.
d. Copy the first two lines of code highlighted in Figure 11. Position the insertion point at the end of the second line and press the Enter key twice. Make the changes noted in the comments to the lines you just pasted.
e. Position the insertion point below the intCount = 1 line and press Enter twice.
f. Type the statement that assigns text to the strOut variable as shown in Figure 11, and then press Enter twice.
g. Enter the rest of the code shown in Figure 11.
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Figure 11 Do While Loop
h. Click Save, and then run the DisplayValueIncrease procedure.
i. Type Mustang into the input box, and then click OK.
j. Examine the number displayed, and then click OK in the message box. Close the VB Editor, and then exit Excel.
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Sub SorcsyMake ()

' SortsyMake Macro

Range ("A3:I15") .Select
Activellorkbook.Workshests ("Classic Cars”) .Sort.SortFields.Clear
ActiveWorkbook. Worksheets ("Classic Cars") .Sort.SortFields.Add Key:=Range( _
"R4:R15"), SortOn:=x1SortOnValues, Order:=x1Descending, DataOption:
x1SortNormal
With ActiveWorkbook.Worksheets ("Classic Cars").Sort
.SetRange Range ("A3:115")
.Header = xl¥es
.MatcnCase = False
.Orientation = xlTopToBottom
.SortMethod = x1Pin¥in
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Make

Cadillac ElDorado
Chevrolet Impala
Pontiac GTO
Oldsmobile GTO
Ford Deuce Coupe
Chrysler 300C
Mustang

Lincoln Continental
Thunderbird
Convette Stingray
Packard Phaeton
Stutz Bearcat

Model
Year
1963
1959
1966
1970
1932
1957
1964
1960
1955
1966
1932
1914

Model

Convertible
Convertible
Convertible
Hardtop
Hardtop
Convertible.
Convertible
Continental
Hardtop
Convertible.
Hardtop
Hardtop

The Classic Car Cruise

51412011
Owner's First  Owner's Last
Name Name
Jery Comes
Myra Lynch
Dan Davids
Leonardo Simboli
Jane Johnston
Glenn Ament
Joe Morgan
Lee Petrovits
Fred Way
Fred Fletcher
Tom McCreary
Bayard Street

Acquired Horsepower

2008
1972
2001
1971
1954
1984
1999
1986
1975
1966
1945
1947

289
195
375
390
145
300
180
21
225
350
100

89

Value

§9,500.00
§12,000.00
§15,000.00
§16.000.00
§18,750.00
§19,000.00
$26,000.00
$33,000.00
$42,000.00
§72,000.00
§98,000.00

§150,000.00

Insurance

$950.00
$1.200.00
§1,500.00
$1,600.00
§1,875.00
§1,900.00
$2,600.00
$3,300.00
$4,200.00
§7.200.00
§9,800.00
§15,000.00
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Make

Thunderbird
Stutz Bearcat
Pontiac GTO
Packard Phaeton
Oldsmobile GTO
Mustang

Lincoln Continental
Ford Deuce Coupe
Convette Stingray
Chrysler 300C
Chevrolet Impala
Cadillac ElDorado

Model
Year
1955
1914
1966
1932
1970
1964
1960
1932
1966
1957
1959
1963

Model

Hardtop
Hardtop
Convertible.
Hardtop
Hardtop
Convertible.
Continental
Hardtop
Convertible.
Convertible
Convertible
Convertible

The Classic Car Cruise

511412011
OvnersFirst  OwnersLast pcquired Horsepower  Value

Fred Way 1975 225 $42,000.00
Bayard Strest 1047 89 §150.000.00
[ p— % ]515.000.00
Tom 96.000.00
Leonar 16.000.00
Joe 5.000.00
e The rate increase for the Mustang is 19500 o 000,00
Jane 16.750.00
Fred 72.000.00

Glenn oK 19.000.00
Myra 12,000.00

Jerry 5950000

Insurance

5420000
$15,000.00
5150000
59,800.00
5$1,600.00
5260000
5§3,300.00
51,875.00
5§7,20000
5$1,900.00
5$1,20000
595000
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Private Sub cmdIns_Click()

'Declare Variables

Dim curIns As Currency

Dim curValue As Currency

Dim curIncreaseAmt As Currency
Dim curNewPremium As Currency
Const sngRate As Single = 0.075

'Get information from the form
txtvalue.SsetFocus
curValue = txtvalue.Text

txtInsurance.SetFocus
curIns = txtInsurance.Text

'calculate Insurance Increase based on Value
curIncreaseAmt = curValue * sngRate
'calculate new total insurance premium
curNewPremium = curIns + curIncreaseAmt

'Display new insurance amount

MsgBox "Your new Insurance Premium is: " _
& Format (curNewPremium, "Currency"), vbInformation, "Premium"

End Sub
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'Handles Quit Button Click Event

'Declare variables
Dim intResponse As Integer

'show message box with quit question
intResponse = MsgBox ("Are you sure you want to Quit?", _
vbYesNo + vbCritcal, "Quit?")

'Check to see that the user is really quitting. Response = 6
If intResponse = 6 Then

DoCmd. Save

DoCmd.Quit
End If




image6.png
Dim sngRate As Single
Dim intYear As Integer

'Get the model year
txtModel.SetFocus
intYear = txtModel.Text

'Determine if the Model Year is before 1955

'If it is the increase rate is 5% other wise it is 7.5%
If intYear < 1955 Then

sngRate = 0.05

Else

sngRate = 0.075

End If
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Private Sub cmdCredit_Click()
'Declare variables
Dim strRating As String
Dim strCredit As String

'Get data from form
cboRating.SetFocus
strRating = cboRating.Text

'Determine credit approval
Select Case strRating
Case Is = "A"

strCredit = "Yes"
Case Is = "B"
strCredit = "Maybe"
Case Is = "C
strCredit = "No"
End Select

'Move data to form
txtCredit.SetFocus
txtCredit.Text = strCredit

End Sub
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'Declare variables

Dim
Dim
Dim
Dim
Dim

strModel As String
curInsAmt As Currency
curTotalInsaAmt As Currency
intCount As Integer
strout As String
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'Initialize Counter
intCount = 1

'Begin loop to calculate and output 5 year premiums

For intCount =1 To 5
curTotalInsAmt = curTotalInsAmt + curInsAmt

strout = strout & vbCrLf & "Year " & intCount & " " _
& Format (curTotalInsAmt, "Currency")

Next

routput results|
MsgBox strout, vbInformation, "5 Year Premium"
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Sub DisplayValueIncrease ()
'Declare variables

Dim
Dim
Dim
Dim
Dim
Dim

strModel As String

curInsAmt As Currency
curNewvalue As Currency
curTotalInsAmt As Currency
curTotalvalue As Currency
curvValueIncrease As Currency

Const sngRate As Single = 0.035

Dim
Dim

intCount As Integer
strout As String
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Bctivecell.offset (0, 8).Select
curInsAmt = ActiveCell.Value

ActiveCell.offset (0, -1).Select 'change to (0,-1) from (0,8)
curTotalValue = ActiveCell.Value 'change to curTotalValue from curInsAmt

'Initialize Counter
intCount = 1

'Set the column headings for the message box
strout = "value" & vbTab & vbTab & "Insurance”

'Begin the loop
Do While intCount <= 5
curTotalInsAmt curTotalInsAmt + curInsAmt
curvalueIncrease = curTotalvalue * sngRate
curTotalvalue = curTotalvalue + curValueIncrease
strout = strout & vbCrLf & Format (curTotalvalue, "Currency") _
& vbTab & vbTab & Format(curTotalInsAmt, "Currency")
intCount = intCount + 1
Loop
MsgBox strout, vbInformation, "5 year values and Insurance Information”




